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August 25 should be an international holiday. Well, it
should be if you’re a Linux user. Or, maybe it should
be a religious holiday. For many Linux users, Linux
is somewhat akin to a religion. That’s the day in
1991 when Linus Torvalds made the comp.os.minix
newsgroup post announcing Linux 0.01. That initial
announcement read as follows:

Hello everybody out there using minix -

I'm doing a (free) operating system (just a hobby, won't be
big and professional like gnu) for 386(486) AT clones.
This has been brewing since april, and is starting to get
ready. I'd like any feedback on things people like/dislike in
minix, as my OS resembles it somewhat (same physical
layout of the file-system (due to practical reasons) among
other things).

I've currently ported bash(1.08) and gcc(1.40), and things
seem to work. This implies that I'll get something
practical within a few months, and I'd like to know what
features most people would want. Any suggestions are
welcome, but I won't promise I'll implement them :-)

Linus (torvalds@kruuna.helsinki.fi)

PS. Yes - it's free of any minix code, and it has a multi-
threaded fs. It is NOT portable (uses 386 task switching
etc), and it probably never will support anything other
than AT-harddisks, as that's all I have :-(.

— Linus Torvalds

The initial code release came a couple of weeks
later. You can download Linux 0.01 here, if you want
to take a look. With a little digging around on the
internet, you should be able to compile the source
code, and run it in VirtualBox.

According to Torvalds, Linux began to gain
importance in 1992 after the X Window System was
ported to Linux by Orest Zborowski, which allowed
Linux to support a GUI for the first time.

What we commonly call and hold dear as Linux
almost had a different name. Torvalds briefly
considered “Linux,” a play on his first name and
Unix, but considered it too egotistical. So, he
changed the name to “Freax,” combining the words
“free,” “freak,” and “Unix.” However, Ari Lemmke,
one of the volunteer administrators of the FTP server
at the Helsinki University of Technology at the time,

thought “Freax” was a dumb name, and took it upon
himself to rename it Linux. The name stuck.

Tux, the Linux mascot, didn’t come about until five
years later. In 1996, when they were about to select
the mascot, Torvalds mentioned he was bitten by a
little penguin (Eudyptula minor) on a visit to the
National Zoo & Aquarium in Canberra, Australia.
Larry Ewing provided the original draft of today's well
known mascot based on this description. The name
Tux was suggested by James Hughes as derivative
of Torvalds' UniX, along with being short for tuxedo,
a type of suit with color similar to that of a penguin.

********************

This month’s magazine cover was designed by
Meemaw. It celebrates the 29th anniversary of the
Linux announcement, the announcement of the IBM
PC on August 12, 1981, and August being
Watermelon Month. During the dog days of summer,
there’s little else as refreshing as some ice cold
watermelon to cool us off.

Until next month, I bid you peace, happiness,
prosperity, serenity, and continued good health!

Looking for an old article?
Can't find what you want? Try the

PCLinuxOS Magazine's
searchable index!

From The Chief Editor's Desk ...

https://pclosmag.com/searchpclosmag.html
http://www.oldlinux.org/Linux.old/Linux-0.01/


PCLinuxOS Magazine Page 4

by The Inkscape Team

Smoother performance, HiDPI support, new &
improved Live Path Effects & native macOS app

After a little over three years in development, the
team is excited to launch the long awaited Inkscape
1.0 into the world.

Built with the power of a team of volunteers, this
open source vector editor represents the work of
many hearts and hands from around the world,
ensuring that Inkscape remains available free for
everyone to download and enjoy.

In fact, translations for over 20 languages were
updated for version 1.0, making the software more
accessible to people from all over the world.

A major milestone was achieved in enabling
Inkscape to use a more recent version of the
software used to build the editor's user interface
(namely GTK+3). Users with HiDPI (high resolution)
screens can thank teamwork that took place during
the 2018 Boston Hackfest for setting the updated-
GTK wheels in motion.

Smoother performance & first native macOS
application

This latest version is available for Linux, Windows
and macOS. All macOS users will notice that this
latest version is labelled as 'preview', which means
that additional improvements are scheduled for the
next versions. Overall, 1.0 delivers a smoother,
higher performance experience on Linux and
Windows, and a better system integration (no more
XQuartz!) on macOS.

So many new bells and whistles

One of the first things users will notice is a
reorganized tool box, with a more logical order.
There are many new and improved Live Path
Effect (LPE) features. The new searchable LPE
selection dialog now features a very polished
interface, descriptions and even the possibility of
marking favorite LPEs. Performance
improvements are most noticeable when editing
node-heavy objects, using the Objects dialog, and
when grouping/ungrouping.

The new Live Path Effects Selection dialog

Canvas flexibility & more for freestyle drawing

Freestyle drawing users can now mirror and rotate
the canvas, and test out Xray and Split-view
modes. The new PowerPencil mode of the Pencil
tool provides pressure-dependent width and it is
finally possible to create closed paths. Inkscape now
allows you to vectorize line drawings, too, in the
new unified Trace Bitmap dialog. New path effects
that will appeal to the artistic user include Offset,
PowerClip and PowerMask LPEs.

The Split View mode allows to easily edit and preview your
drawing

Duplicate guides, Corners & Hairlines for
technical drawing

Users who work on technical drawings will
appreciate being able to create a duplicate guide,
aligning grids to the page, the Measure tool's path
length indicator and the inverted Y-axis, which

Introducing Inkscape 1.0

http://www.dosgamesarchive.com/
https://inkscape.org/news/2020/05/04/introducing-inkscape-10/
https://inkscape.org/release/
https://inkscape.org/release/
https://inkscape.org/news/2020/05/04/roots-and-shoots-inkscape-project/
https://wiki.inkscape.org/wiki/index.php?title=Release_notes/1.0#Translations_.5Bas_of_2019-12-18.5D
https://inkscape.org/en/news/2018/05/22/2018-boston-inkscape-hackfest/
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makes coordinates match between the SVG code
and the Inkscape user interface. Potential favorite
new LPEs might be Corners (Fillet/Chamfer) for
even rounding / cutting of path corners, Ellipse from
Points for construction of circles and ellipses and
Measure Segments for architectural plans and
other real-world object measuring. A new
functionality with the Circle Tool means it can create
closed arcs (fillets) with the click of a button. When
it comes to SVG and CSS, Inkscape 1.0 can make
use of SVG2 vector hatches, and can render and
export hairlines.

Even rounding or blunting of corners by a specified radius with
the Corners Live Path Effect

PDF export, text & document fixes for designing

Designers will appreciate being able to export PDFs
with clickable links and metadata. They can enjoy
new palettes and mesh gradients that work in the
web browser, as well as the handy on-canvas
alignment for objects. When it comes to wrangling
text in Inkscape, variable font support, browser-
compatible flowed text, simplified, yet powerful
line-height settings will make that a joy. New
templates for different screen sizes, margin guides

and a colorful checkerboard background are now
available. Inkscape 1.0 even features an extension
for creating interactive mockups to simulate user
interaction with an app in the web browser for
presentations to clients and usability testing.

Alignment of objects on cavas with a new set of alignment
handles

Customizable themes, icons, fonts & UI

For users interested in customizing their user
interface, Inkscape 1.0 allows for plenty of tinkering.
From menus and toolbars to page sizes and custom
font directories, there is lots to discover. Choose
from your installed themes to give Inkscape a dark
or bright interface, and select one of the available
icon sets, which include customizable single-color
icons and the newly-designed multicolor icon set.
The new dialog for saving the current file as a
template, with keywords and title, allows you to
always have the template you need available.

Switching themes on-the-fly

Some fundamental changes

The extensions system has undergone some
fundamental changes in version 1.0. Over the
years, Inkscape users have become used to working
with third-party extensions, such as various ones
used for laser cutting and exporting to file formats
which are not a native part of Inkscape. While
outreach to extension developers was undertaken
as Inkscape migrates towards Python 3 and a more
logical and fully tested extensions API (now hosted
in a separate repository), not all third-party
extensions have been brought forward to be
compatible yet. This will mean that 1.0 may not
allow some users to continue with their normal
extensions workflow.

For more details on specific updates in Inkscape
1.0, check out the Release Notes.

Download Inkscape 1.0 now! Or, wait until the
package reaches the PCLinuxOS repository, and
install it via Synaptic.

The PCLinuxOS Magazine

Created with Scribus

Introducing Inkscape 1.0

http://www.scribus.net
https://wiki.inkscape.org/wiki/index.php?title=Release_notes/1.0#Inkscape_1.0
https://gitlab.com/inkscape/extensions
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by Meemaw

May 4, 2020

“After a little over three years in development, the team is
excited to launch the long awaited Inkscape 1.0 into the
world.

Built with the power of a team of volunteers, this free and
open source vector editor represents the work of many
hearts and hands from around the world, ensuring that
Inkscape remains available free for everyone to download
and enjoy.”

Finally! Inkscape 1.0 is out!

Reading the release notes, we can see that there
are several new features. I’m going to review just a
few.

Rotate the Entire Canvas

Nice! A cool feature I never knew I wanted. While
pressing <SHIFT> + <CTRL>, scroll with your
mouse to rotate the canvas to your desired angle.
The bottom right corner of your window now has a
box labeled “R” that shows your angle of rotation
(center, top).

On-Canvas Alignment

On-canvas alignment allows you to use many
alignment options on the fly, rather than opening
another window with Align & Distribute. To enable
this, open Object > Align and Distribute and toggle
the on-canvas button, located just under the word
Align in the tool window. After that, the window won’t
need to be opened.

Clicking the selection 3 times shows the handles
(click 1 is select/resize, click 2 is rotate, and click 3 is
align)

You’ll notice the handles are different now. The ones
in the corners align the objects to that corner. The
ones on the sides, top and bottom are to align left
and right, top and bottom. The square in the center
is the align center. Clicking the square aligns
horizontally to center. If you hold down the Shift key,
it aligns to center vertically.

Custom Inkscape Themes

Earlier, there were only one or two ways to
personalize certain things on your Inkscape
interface, without actually hazarding a trip to root
and file alteration. Now you can just go to Edit >
Preferences, select the Interface drop down, and
select Theme. Here you can change the entire way
Inkscape looks and adjust icon themes and sizes
separately.

Live Path Effects Makeover!

The live path effects tool has been changed
considerably.

If you want to tinker around with these, select Path >
Path Effects to bring up the menu. Then just select
any path and hit the “+” icon to Add Path Effect,
which brings up this window shown below.

Inkscape Tutorial: Inkscape 1.0 New Features

https://wiki.inkscape.org/wiki/index.php/Release_notes/1.0#Inkscape_1.0
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In previous versions, the window only had a list of
the live paths you could choose. Now they are in a
different window that shows a sample of the effect,
so you know you are getting the right one. In the box
above, you can see three different ways to display
the effects (top center of window). You can choose
icons, smaller icons or a list (which has icons on the
left end of the description).

More Compact Tool Controls Bar

Some control buttons that have been mutually
exclusive (e.g. right-aligned, left-aligned, justified)
have been combined into drop-down lists, so they
now take up less space.

Context menu

The menu that appears after a right-click on the
canvas has been extended at the bottom with the
following items, which makes locking/unlocking and
hiding/unhiding individual objects much easier:
• Hide selected objects
• Unhide objects below (the mouse cursor)
• Lock selected objects
• Unlock objects below (the mouse cursor)

Pinch-to-zoom

On supported hardware (trackpad, touchpad, multi-
touch screen), the canvas can be zoomed with the
two-finger pinch gesture. My laptop touchpad
doesn’t work, but you should try yours. My daughter
has an older Wacom Bamboo (CTH-661) and the
pinch-to-zoom works when it’s connected to my
husband’s laptop running PCLinuxOS Xfce.

Split View and X-ray Modes

Both of these tools make it easier to see what you
have in your drawing, especially if you have several

things stacked. With the Split View and the X-ray,
you can see them and it will be easier to grab the
one you want and edit it, without having to use trial
and error to grab what you want or unlayer objects
to find the correct one. Split view divides your page
in half and shows one side as it is, and the other
side with just the frames of your objects without the
colors. The line can be moved left & right or up &
down using your mouse. X-ray view puts a resizable
transparent circle on the drawing that lets you look
past all the color and only at the frames of each
object.

Split view is found in the View menu or can be
activated by pressing <Ctrl> + 6.

X-ray view is found in the View menu or can be
activated by pressing <Alt> + 6. The circle that you
use can be made larger or smaller by pressing Edit
> Preferences > Rendering > Rendering XRay
radius.

Snapping

In Edit > Preferences > Behavior > Snapping, a
new option was added to disable snapping in new
documents or files that are opened with Inkscape for
the first time. It’s a checkbox saying Enable
snapping in new documents.

Center Page in Window

You might have noticed a new tool up in the toolbar
with the Zoom buttons (Zoom to fit selection in
window, Zoom to fit drawing in window, and Zoom to
fit page in window). Now there is also a tool that
allows you to center your zoomed object in the
window.

If you have zoomed in on
an object, you can center
that in your window
without altering the zoom
you have.

It looks like we’re all going to be doing some
experimentation. This isn’t the limit of the new
features!

Inkscape Tutorial: Inkscape 1.0 New Features
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INGREDIENTS:

1 lb. lean ground beef
1/2 cup chopped onion
3 tablespoons all purpose or unbleached flour
1 tablespoon beef-flavor instant bouillon
2 tablespoons steak sauce
2 cups milk

DIRECTIONS:

In a large skillet, cook ground beef and onion over
medium-high heat until beef is thoroughly cooked,
stirring frequently.

Stir in flour, bouillon and steak sauce. Gradually stir
in milk. Cook and stir 4 to 6 minutes or until mixture
boils and thickens, stirring frequently.

If desired, serve over
biscuits, mashed
potatoes or cooked
rice.

The PCLinuxOS
Magazine

Created with
Scribus

Support PCLinuxOS! Get Your Official

PCLinuxOS
Merchandise Today!

PCLinuxOS Recipe Corner

Hamburger Gravy
14 g. carbohydrate

http://www.scribus.net
http://www.cafepress.com/pclinuxos
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My CPU is whispering goodbye

Windows sad affair

My CPU is whispering goodbye

Windows nightmare

Ours was a love song never in tune

All over now not too soon

Linux I started Windows I parted

And you know why

Linux and I

Give it a try

My CPU is whispering a sigh

Linux never a care

My CPU is whispering a sigh

Linux love its software

Ours is a love song ever in tune

Download it now do it soon

Linux get started I'll never be parted

And you know why

Linux and I

Give it a try

ms_meme's Nook: Linux And I

MP3 OGG

http://pclosmag.com/html/Issues/202008/files/linuxandi.mp3
http://pclosmag.com/html/Issues/202008/files/linuxandi.ogg
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Screenshot ShowcaseScreenshot Showcase

1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Disclaimer

Posted by golf4fun, July 8, 2020, running KDE.

http://www.pclosusers.com/services-signup.php
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by Paul Arnote (parnote)

Google Photos Sports New Logo, Implements
Design Changes

Google Photos services over 1,000,000,000 (yes,
billion) users across the world every month. Even if it
is from the evil Google Empire [bwahahahaha],
there’s hardly any photo service that’s easier or
more convenient to use. But, because it’s Google,
they really just can’t help themselves when it comes
to screwing with things that aren’t broken.

To start with, Google has changed the logo for
Google Photos. Above is an image showing the
progression of the various logos Google has used.
The Picasa logo actually made sense. The opening
in the middle looked like the aperture of a lens (and
I’m thinking specifically of Canon’s 50mm f 1.8 lens
for their DSLRs, which utilizes a five blade aperture).
Then came the middle logo, which some could

argue (after several drinks) still resembled …
somewhat … the aperture of a lens. Now, Google
has thrust the latest logo upon us, depicted on the
right. I’m not sure what flower petals have to do with
photography (other than flowers make for some nice

photo subjects from time to time). Nothing about the
new logo reaches out and says PHOTOS to you. I
would expect this kind of logo for a “Google
Gardening” app. To say that it is way, way
oversimplified is an understatement. As Google has
shown us, you can simplify a logo too much, to the
point that it loses its identity.

But Google also didn’t just stop with the new logo for
Google Photos. They also had to mess up a
perfectly functional user interface. Many common
tasks, like viewing shared photos from a photo
“partner,” went from being just one click away, to
being buried in a menu that now requires multiple
clicks to access. Instead, Google decided to give
photo memories – technically called “Memories”

carousel – a larger presence. It was always there
before, accessible with just one click, but now it
occupies a ridiculous amount of screen real estate,
with a garish appearance. Google estimates that
120 million people every month – or roughly 10
percent or so of its monthly visitors – access the
feature every month. Sure. Let’s cater to the 10
percent, and make the other 90 percent of users
suffer. Because that makes so much sense. [smh!]

Of course, I’ll continue to use Google Photos. For
me and my wife, the real attraction for Google
Photos is what happens in the background. We both
use Google Pixel 3 phones, which gives us unlimited
storage of photos at full size and resolution (one of
the “perks” of using the Google Pixel 3 phone). Most
other users of Google Photos only get to store
recompressed, smaller versions of their photos.
Plus, almost as soon as we shoot a picture (or
whenever our phones find a viable wifi network), our
photos are uploaded automatically in the
background. Then, we can access them from any
device that can connect to Google Photos.

Even though we have a DSLR and a slew of other
quite capable digital cameras, we usually have our
phones with us no matter where we are. And that is
important when you have two active children who do
cute things all day long that you want to capture in a
photo. That isn’t necessarily the case with any of our
standalone cameras. We bought the Pixel 3’s
because it had the absolute best camera of any of
the phones available. We know that we use the
camera on our phones a lot to take pictures of the
kids, so having a high quality camera was the most
important consideration when we bought our new
phones.

Still, I wish Google would stop changing functional
interfaces and features just for the sake of change.

Short Topix: Linux Caves
To Social Justice Movement
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That is, after all, what it seems they like to do.
Hmmm. Maybe that’s what they tell the Google
interns that rotate through there. Take this perfectly
functioning app and let’s see how much you can eff
it up before your internship is over.

25 Android Apps That Steal Your Facebook Login
Information

IF you still have a Facebook account (lots of people
have left the platform in recent years), there is a new
threat from rogue Android apps that will attempt to
steal your Facebook login credentials.

Google has removed 25 of those rogue apps from
the Google Play store, after French cybersecurity
firm Evina identified the Facebook credential-
stealing malware. At right is the full list of malware
apps that Evina discovered, from the Evina website.

Im
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Short Topix: Linux Caves To Social Justice Movement

http://www.dosgamesarchive.com/
https://www.evina.com/they-steal-your-facebook/


PCLinuxOS Magazine Page 13

The list of apps include pedometers, flashlight apps,
live wallpaper apps, card games, file managers, and
other assorted apps. While they are functional in
terms of their intended use, the malware apps will
also open up a browser window with a fake
Facebook login page. When the user fills in the login
credentials, the login information is sent to a remote
server for collection. The remote server has since
been shut down.

Even though Google has removed the malware from
the Google Play store, users should check their
Android devices to make sure the apps are not
installed on those devices. Exclusion from the
Google Play store will not affect apps that are
already installed on devices. It is up to the end user
to remove these apps that might have been installed
on their devices.

Stay vigilant! I’ve said it before, and I’ll say it again:
your data/information is the modern currency d’jour.

Facebook Improperly Shares User Data With
Developers … AGAIN!

Just when you thought it might be safe to go into the
water again, the same ol’ shark that you thought was

dead resurfaces, looking for another victim.
Welcome to the premiere of Jaws 45 in 4D. And so it
goes with Facebook, who was discovered to be
improperly sharing user information – email
addresses, birthdays, language, gender, etc. – long
past the time that they should have, according to a
Mashable article.

Facebook, on its blog, offered a typically vague
explanation. When pressed by Mashable for
additional information, Facebook did not respond.

If all of this sounds familiar, that’s because it is. The
very same situation was discovered in 2018 and

2019, and similar statements (yawn) were offered at
those times for the overabundance of information
given to third-party developers. Follow the links if
you think you can stay awake reading essentially the
same statement … over … and over … and over
again.

It’s things like this that make me happy to have
NEVER been a Facebook user. Nor will I ever be.

NASA: Watch 10 Years Of Solar Activity

On June 2, 2010, the Solar Dynamics Observatory
was deployed. Its mission: watch the sun. While
doing so, it took an image of the sun every 0.75
seconds. Over its 10+ years of observation, that
amounts to over 425 million solar images.

To commemorate the 10 year milestone, the SDO
team put together a video of the sun from that
massive amount of images that spans the 10 years
of the mission so far. Each day in the video is one
second of the video. It even sports a custom music
soundtrack. As such, the video goes for 61 minutes.

Podcasts For
Linux & BSD

Short Topix: Linux Caves To Social Justice Movement

https://www.jupiterbroadcasting.com/show/linux-action-news/
https://www.jupiterbroadcasting.com/show/linuxun/
https://www.jupiterbroadcasting.com/show/techsnap/
https://www.jupiterbroadcasting.com/show/headlines/
https://www.jupiterbroadcasting.com/show/choose/
https://www.jupiterbroadcasting.com/show/bsdnow/
https://www.jupiterbroadcasting.com/
https://mashable.com/article/facebook-gave-users-data-5000-third-party-developers/
https://about.fb.com/news/2020/07/improving-data-limits-simplifying-terms/
https://about.fb.com/news/2018/12/facebooks-partners/
https://developers.facebook.com/blog/post/2019/11/05/changes-groups-api-access/
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In it, you can see transits of planets, as well as solar
eruptions.

You can view the video here. Caution: it’s quite
hypnotic, and difficult to look away.

Linux Caves To Social Justice Movement

If you haven’t heard about the current levels of
social unrest sweeping across the landscape, you
must have been the lone survivor at a long lost,
forgotten moon base with no way to communicate
back to the “Mother Planet.” The world is descending
into absolute crazy madness!

Well, not wanting to be left out of the “virtue
signaling” mix, Linus Torvalds signed off onto
removing “offensive” terms from the Linux kernel,
such as slave, master and blacklist. According to an
article on The Register, the removal of these terms is
supposed to occur immediately, starting with the
latest rc5 release of the 5.8 Linux kernel.

Sooooooo … where does all of this end? What
about all of the curse words that are dispersed
throughout the kernel code? Won’t some puritanical

sort of person take offense to the appearance of
those “offensive” words?

Gauging by the comments to the article on The
Register (and elsewhere across the internet), the
changes are not being well received by Linux
aficionados. There is, to say the least, a LOT of
backlash against the forthcoming changes, and most
of it centers around the types of questions I asked in
the previous paragraph.

I Know What You Downloaded Via BitTorrent

Do you think you’re safe downloading BitTorrents
without a VPN? Prepare to have your mind changed
in 1 … 2 … 3 seconds.

Even though users can download perfectly legal
“stuff” via torrents, such as Linux distros, BitTorrents
are commonly used for peer-to-peer file sharing of
copyrighted material, like music and movies, and
that is where BitTorrents get their bad rap. Some
ISPs even attempt to throttle the download speed of
torrent downloads to discourage users from
downloading torrents.

Point your browser over to
iknowwhatyoudownload.com. Once there, you will
see your IP address listed at the top of the page,
and all of the BitTorrents downloaded from that IP
address listed below it. If the IP address listed is
indeed yours, you might be quite surprised at the
information revealed. However, if the IP address
listed is one of the servers for your VPN service,
then relax and know that the VPN is doing its
intended job.

I use a VPN, and it’s quite an eye opener to see
what other customers of the VPN are downloading
through the VPN server. None of it points back to the
actual user, but it’s still quite revealing.

I know. I know. Some of you are going to say
something along the lines of “well, I have nothing to
hide,” or “I don’t download torrents, so I have
nothing to worry about.” This isn’t about whether you
have anything to hide or not. This also isn’t about
whether or not you download torrents. This is about
privacy. Why should your IP address be associated
with the files you upload or download? Is it really the
business of anyone else what things interest you?

Short Topix: Linux Caves To Social Justice Movement

https://www.edx.org/course/introduction-linux-linuxfoundationx-lfs101x-0#!
https://www.youtube.com/watch?time_continue=6&v=l3QQQu7QLoM&feature=emb_logo
https://www.theregister.com/2020/07/13/linux_adopts_inclusive_language/
https://forums.theregister.com/forum/all/2020/07/13/linux_adopts_inclusive_language/
https://iknowwhatyoudownload.com/
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“No Log” VPN Provider Leaks User Database
Online

Cybersecurity firm CompariTech reported that Hong
Kong based, “no logs” UFO VPN has been leaking
user database files for millions of its users … daily
… due to poor security. The information includes:

* Account passwords in plain text

* VPN session secrets and tokens

* IP addresses of both user devices and the VPN
servers they connected to

* Connection timestamps

* Geo-tags

* Device and OS characteristics

* URLs that appear to be domains from which
advertisements are injected into free users’ web
browsers

There are a literal TON of people who would like to
snag a record of your online activity, and among
them are governments, ISPs, individuals, and
advertisers. It is your duty to protect your online
activity as much as possible from snooping eyes.

Besides storing the information in easy-to-read plain
text files, none of the files were encrypted or
secured in any way. The first database breach was
reported by CompariTech to UFO VPN on July 1,
2020. A subsequent release of an updated and even
larger database file was discovered on July 20,
2020, posted at a different IP address.

UFO VPN boasts serving 20,000,000 users, and
possessing “bank level security.” I don’t know about
you, but that’s not a bank I’d want to put my money
into. While it’s unknown just how many records were
leaked, it is possible that ALL UFO VPN records
were compromised.

Don’t worry. This gets even better. There are six
Android VPN apps that appear to use the same
codebase and setup as UFO VPN. They are:

* Fast VPN

* Free VPN

* Super VPN

* Flash VPN

* Secure VPN

* Rabbit VPN

The decision for UFO VPN users to leave should be
an easy one. And overall, this gives VPN services a
black eye. But keep in mind that VPN services that
are REPUTABLE deserve your trust and business.
UFO VPN should not fall into that category. There
are VPN services that do not keep logs (UFO VPN
just said they didn’t, and the database leak proves

otherwise), and that go out of their way to protect
their clients' privacy and anonymity.

Want to know which VPN service provider is worthy
of your trust and business? Check out this “Best
VPN Service for 2020” article from TechRadar.

The use of a VPN is NOT the cure-all for protecting
your privacy. But, it is a very important cog in a gear
that makes up a whole series of things that can help
protect your privacy, like enabling two-factor
authentication whenever possible, making smart
choices for your web browser, stop using the same
passwords on multiple sites, etc. If someone or an
entity wants to track your movements across the
web, they will find a way. Using a good quality,
trustworthy VPN service will help make tracking your
activity more difficult.

Are viruses,
adware, malware &
spyware slowing
you down?

Get your PC back
to good health
TODAY!

Get

Does your computer run slow?

Are you tired of all the "Blue Screens
of Death" computer crashes?

Download your copy today! FREE!

Short Topix: Linux Caves To Social Justice Movement

http://www.pclinuxos.com/?page_id=10
https://www.comparitech.com/blog/vpn-privacy/ufo-vpn-data-exposure/
https://www.techradar.com/vpn/best-vpn
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by Electronic Frontier Foundation
Reprinted under Creative Commons Attribution
License

Many of our digital rights are impacted by COVID-
19. Now more than ever, EFF is dedicated to
ensuring that technology supports freedom, justice,
and innovation for all the people of the world.

Surveillance. Governments around the world are
demanding extraordinary new surveillance powers
that many hope will contain the virus’ spread. But
many of these powers would invade our privacy,
inhibit our free speech, and disparately burden
vulnerable groups of people. Mindful of the stakes,
we ask three questions when analyzing proposals
that would provide greater surveillance powers to
the government: Would the proposal work? Would it
excessively intrude on our freedoms? Are there
sufficient safeguards? Different proposals raise
different issues. For example:

• We oppose dragnet surveillance of the general
public to identify infected people. This includes
dragnet surveillance cameras in public places that
use face recognition or thermal imaging, and
mounting such technologies on drones.

• We oppose monitoring quarantine of COVID-19
patients with ankle GPS shackles or compulsion
to download tracking apps.

• We oppose giving police officers access to any
COVID-19 public health data, including the
addresses of people who tested positive.

• We oppose immunity passports and verified
credentials of test results. Gatekeeping systems
that require people to present a digital token of
supposed health in order to enter various spaces
are a worrisome step towards national digital
identification.

• We oppose automated contact tracing based on
phone location data. It is insufficiently granular to
identify when two people were close enough
together to transmit the virus, but it will expose
where we’ve been and what we’ve been doing.

• Bluetooth proximity is the most promising
approach so far to automated COVID tracking.
But no app will work absent widespread testing
and interview-based contact tracing. Any app
needs rigorous security testing and data
minimization. No one should be forced to use it.

• Any use of aggregate location data to inform public
health decisions need strict safeguards.

Many new government surveillance programs are
being built in partnership with corporations that hold
vast stores of consumers’ personal data. We need
new laws to protect our data privacy.

Free Speech. The free flow of ideas about COVID-
19 is vital. This includes anonymous whistle-blowing
about containment efforts, online criticisms of
government responses to the crisis, and prisoner

access to social media to tell the world about
outbreaks behind bars. Governments will inevitably
abuse any new powers to censor what they deem
false information about the virus. When online
platforms increase their reliance on automated
content moderation, in part because human
moderators cannot safely come to work, those
moderation “decisions” must be temporary,
transparent, and easily appealable. Platforms should
take into account the Santa Clara Principles for
transparent and accountable content moderation.
We are troubled by Facebook’s plan to limit speech
about public protests.

Innovation. New technologies and ideas can help
address the public health crisis. We must have free
and open access to scientific knowledge about the
virus. Tinkerers should be able to fix medical
devices, and have easy online access to repair
manuals. Open innovation in medical technology will
save lives. The federal government should exercise
its power to stop patent trolls from endangering
COVID-19 testing and treatment, and should not
increase patent terms for technologies related to this
health crisis.

Fiber For All. Social distancing is causing many of
us to spend more time on the Internet. But not all
Americans have fast and competitively-priced
Internet access. So EFF is advocating for federal
and state laws to redouble efforts to build better
broadband for everyone. You can take action to
support these bills.

Government transparency. Government decision-
making about the virus must be transparent. When
governments temporarily close the physical spaces
where they make decisions, for purposes of social
distancing, they must adopt new transparency
accommodations, such as broadcasting their

COVID-19 & Digital Rights

https://www.eff.org/issues/covid-19
http://creativecommons.org/licenses/by/3.0/us/
http://creativecommons.org/licenses/by/3.0/us/
https://www.eff.org/deeplinks/2020/03/eff-and-covid-19-protecting-openness-security-and-civil-liberties
https://www.eff.org/deeplinks/2020/03/protecting-civil-liberties-during-public-health-crisis
https://www.eff.org/deeplinks/2020/04/some-covid-19-surveillance-proposals-could-harm-free-speech-after-covid-19
https://www.eff.org/deeplinks/2020/04/how-eff-evaluates-government-demands-new-surveillance-powers
https://www.eff.org/deeplinks/2020/03/face-surveillance-not-solution-covid-19-crisis
https://www.eff.org/deeplinks/2020/04/thermal-imaging-cameras-are-still-dangerous-dragnet-surveillance-cameras
https://www.eff.org/deeplinks/2020/05/using-drones-fight-covid-19-slipperiest-all-slopes
https://www.eff.org/deeplinks/2020/06/bracelets-beacons-barcodes-wearables-global-response-covid-19
https://www.eff.org/deeplinks/2020/05/covid-19-patients-right-privacy-against-quarantine-surveillance
https://www.eff.org/deeplinks/2020/06/dont-mix-policing-covid-19-contact-tracing
https://www.eff.org/deeplinks/2020/04/telling-police-where-people-covid-19-live-erodes-public-health
https://www.eff.org/deeplinks/2020/05/immunity-passports-are-threat-our-privacy-and-information-security
https://www.eff.org/deeplinks/2020/05/no-california-bill-verified-credentials-covid-19-test-results
https://www.eff.org/deeplinks/2020/05/no-california-bill-verified-credentials-covid-19-test-results
https://www.eff.org/deeplinks/2020/03/governments-havent-shown-location-surveillance-would-help-contain-covid-19
https://www.eff.org/deeplinks/2020/03/verilys-covid-19-screening-website-leaves-privacy-questions-unanswered
https://www.eff.org/deeplinks/2020/05/two-federal-covid-19-privacy-bills-good-start-and-misstep
https://www.eff.org/deeplinks/2020/03/right-anonymity-vital-free-expression-now-and-always
https://www.eff.org/deeplinks/2020/03/government-needs-critics-now-more-ever
https://www.eff.org/deeplinks/2020/03/now-more-ever-inmates-should-have-some-access-social-media
https://www.eff.org/deeplinks/2020/03/now-more-ever-inmates-should-have-some-access-social-media
https://www.eff.org/deeplinks/2020/04/automated-moderation-must-be-temporary-transparent-and-easily-appealable
https://www.eff.org/deeplinks/2020/05/understandable-nonetheless-troubling-facebooks-ban-person-events
https://www.eff.org/deeplinks/2020/05/santa-clara-principles-during-covid-19-more-important-ever
https://www.eff.org/deeplinks/2020/04/automated-moderation-must-be-temporary-transparent-and-easily-appealable
https://www.eff.org/deeplinks/2020/03/embracing-open-science-medical-crisis-0
https://www.eff.org/deeplinks/2020/06/medical-device-repair-again-threatened-copyright-claims
https://www.eff.org/deeplinks/2020/06/medical-device-repair-again-threatened-copyright-claims
https://www.eff.org/deeplinks/2020/05/balanced-copyright-rules-can-help-save-lives-during-covid-19-crisis
https://www.eff.org/deeplinks/2020/04/lengthening-patent-terms-10-years-exactly-wrong-response-covid-19
https://www.eff.org/deeplinks/2020/04/open-innovation-medical-technology-will-save-lives
https://www.eff.org/deeplinks/2020/05/balanced-copyright-rules-can-help-save-lives-during-covid-19-crisis
https://www.eff.org/deeplinks/2020/03/social-distancing-digital-divide-and-fixing-going-forward
https://www.eff.org/deeplinks/2020/04/open-innovation-medical-technology-will-save-lives
https://www.eff.org/deeplinks/2020/05/house-legislation-guarantees-internet-access-those-affected-covid-19
https://www.eff.org/deeplinks/2020/03/social-distancing-digital-divide-and-fixing-going-forward
https://www.eff.org/deeplinks/2020/05/house-passed-legislation-keep-people-online-despite-covid-19-will-senate-follow
https://act.eff.org/action/tell-the-senate-to-help-keep-americans-online-during-the-pandemic
https://www.eff.org/deeplinks/2020/03/governments-must-commit-transparency-during-covid-19-crisis
https://www.eff.org/deeplinks/2020/03/governments-must-commit-transparency-during-covid-19-crisis
https://www.eff.org/deeplinks/2020/03/eff-joins-coalition-urging-judicial-transparency-during-covid-19-crisis
https://www.eff.org/deeplinks/2020/03/eff-joins-coalition-urging-judicial-transparency-during-covid-19-crisis
https://www.eff.org/deeplinks/2020/03/time-now-supreme-court-must-allow-live-cameras-0
https://www.eff.org/deeplinks/2020/05/global-contact-tracing-international-proposals-track-covid-19
https://www.eff.org/deeplinks/2020/05/governments-shouldnt-use-centralized-proximity-tracking-technology
https://www.eff.org/deeplinks/2020/04/apple-and-googles-covid-19-exposure-notification-api-questions-and-answers
https://www.eff.org/deeplinks/2020/04/challenge-proximity-apps-covid-19-contact-tracing
https://www.eff.org/deeplinks/2020/04/covid-19-and-technology-commonly-used-terms
https://www.eff.org/deeplinks/2020/06/germanys-corona-warn-app-frequently-asked-questions
https://www.eff.org/deeplinks/2020/05/californias-lawmakers-must-enact-privacy-rules-advance-covid-19-efforts
https://www.eff.org/deeplinks/2020/04/coronavirus-sweeps-through-jails-and-prisons-officials-crack-down-inmate-speech
https://www.eff.org/deeplinks/2020/05/recognizing-world-press-freedom-day-during-covid-19
https://www.eff.org/deeplinks/2020/06/medical-device-repair-again-threatened-copyright-claims
https://www.eff.org/deeplinks/2020/05/new-low-bad-patent-patent-troll-sues-ventilator-company
https://www.eff.org/deeplinks/2020/04/california-legislator-introduces-fiber-broadband-all-bill
https://action.eff.org/o/9042/p/dia/action4/common/public/?action_KEY=10954
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proceedings. While government responses to public
records requests may be slower during this public
health crisis, the outbreak is no excuse to shut them
down altogether.

Living More Online. We need better online access
to books. As we rely on more online tools to make
working from home and distance learning possible,
Internet users should update their surveillance self-
defense knowledge, for example, to make informed
decisions about using online meeting tools,
organizing online mutual aid efforts, and avoiding
Coronavirus phishing. Although musicians are under
real financial stress due to the virus, mandatory
automated filters to identify alleged copyright
infringement are not the answer.

Protest During COVID-19. People attending
demonstrations during the pandemic should take
special surveillance self-defense precautions. Police
investigating protesters must not have access to
COVID-19 public health information.

Support Our Work! You can donate and download
our ebook, EFF’s Guide to Digital Rights and the
Pandemic, which includes our writings through May
4. You can show your support for digital rights during
video calls with EFF virtual backgrounds, and learn
more by watching our virtual “At Home With EFF”
events.

Screenshot ShowcaseScreenshot Showcase

The PCLinuxOS
Magazine

Created with
Scribus 1.4.1

Posted by OnlyHuman, July 9, 2020, running e24.

COVID-19 & Digital Rights

http://www.pclinuxos.com
http://www.scribus.net
http://pclostalk.pclosusers.com
https://www.eff.org/deeplinks/2020/03/california-public-records-act-essential-right-even-during-state-emergency
https://www.eff.org/deeplinks/2020/03/california-public-records-act-essential-right-even-during-state-emergency
https://www.eff.org/deeplinks/2020/04/sharing-our-common-culture-uncommon-times
https://www.eff.org/deeplinks/2020/03/what-you-should-know-about-online-tools-during-covid-19-crisis
https://www.eff.org/deeplinks/2020/04/sharing-our-common-culture-uncommon-times
https://www.eff.org/deeplinks/2020/06/surveillance-self-defense-attending-protests-age-covid-19
https://www.eff.org/deeplinks/2020/04/copyright-and-crisis-filters-are-not-answer
https://www.eff.org/deeplinks/2020/03/phishing-time-covid-19-how-recognize-malicious-coronavirus-phishing-scams
https://www.eff.org/deeplinks/2020/03/keeping-each-other-safe-when-virtually-organizing-mutual-aid
https://www.eff.org/deeplinks/2020/06/dont-mix-policing-covid-19-contact-tracing
https://supporters.eff.org/donate/pandemicguide--DL
https://supporters.eff.org/donate/pandemicguide--DL
https://www.eff.org/deeplinks/2020/03/cc-backgrounds-video-calls-eff
https://www.eff.org/deeplinks/2020/04/icymi-watch-first-home-eff-virtual-discussion-covid-19-and-digital-rights
https://www.eff.org/deeplinks/2020/04/harden-your-zoom-settings-protect-your-privacy-and-avoid-trolls
https://www.eff.org/deeplinks/2020/06/staying-private-while-using-google-docs-legal-mutual-aid-work


PCLinuxOS Magazine Page 18

by Alessandro Ebersol (Agent Smith)

USB flash drives on Linux have always been
problematic. Aside from the nostalgic unetbootin, the
bootable USB solutions on Linux are always lame.
Either you don't have all the features of the Windows
programs, or it's complicated and laborious to make
it work.

Just for comparison, Windows has Wubi, Rufus,
Yumi, Universal USB Installer, LiLi USB Creator, and
the list goes on and on.

On Linux, we had Unetbootin, which was a very
good tool, but which did not continue development in
the jump from 32 to 64 bits. Really, it did not improve
as it should, lagging behind other solutions. So, we
who use Linux have been orphaned of some
solution that was practical, easy and that effectively
worked.

Ventoy shows up and saves the day

Enter Ventoy, a program that manages the use of
the USB flash drive regarding boot management, the
flash drive being just one ISO, or multi ISO’s. Also,
several types of ISO’s are supported, from Linux,
BSD and even Windows. In addition, they can be
mixed without any problem.

How does Ventoy work?

The concept of Ventoy is so simple that it is
surprising that nobody had thought about this
system before.

Ventoy is a script, a small program, that, when run
(as root), partitions a USB stick (which must be
specified so that the program can do its job), in two
partitions: A 32 MiB partition, in which a loader is
installed, and, which also serves as an EFI partition,
if the pendrive is used to boot on machines with EFI
boot, and the rest of the pendrive is formatted in
exFAT, and the pendrive is labeled Ventoy.

Pendrive’s layout, after Ventoy’s installation

With the above layout, Ventoy becomes compatible
with both systems that boot in legacy MBR mode
and with more modern EFI/GPT systems. Ventoy,
however, does not support secure boot, and it must
be disabled.

As for the first partition, by default, Ventoy selects
the exFAT file system for the primary partition to
store iso files. ExFAT is better compatible with
Windows/Linux/Mac and exFAT is suitable for the
USB stick.

In Ventoy-1.0.11, you can reformat the first partition

with another file system. exFAT, FAT32, NTFS, UDF,
XFS, EXT2, EXT3, and EXT4 are supported.

Note that if you choose XFS, EXT2, EXT3, or EXT4,
the USB drive will not be available on Windows, and
it cannot be used to install Windows. But if you only
use Linux, it will be a good choice, because those
listed filesystems will perform better on Linux.

As for the second partition, there must be an EFI
system partition with the FAT file system, and these
are the mandatory requirements of the UEFI
specifications. Therefore, this partition is created to
hold the EFI boot file and other files needed for
Ventoy. Since these files are very small, 32 MiB is
sufficient. In addition, the EFI partition can also be in
the first partition, but the developer defined it in the
second partition, only because in some versions of
Windows (like Windows 7), only the first partition on
the USB drive is visible to the system. This is good
for the protection of Ventoy.

This partition is very small and used by Ventoy, so it
is best not to change anything on this partition. And
the 1 MB gap? It is used to store the boot loader on
Legacy bios systems.

Using Ventoy

To use Ventoy, you will need a pendrive, or what
some people refer to as a USB flash drive. To write
this article, I used an 8GB USB stick. Again I stress:
Ventoy must be run as ROOT.

Now, to the steps for using Ventoy.

1) Download the script, selecting the Linux version:
https://github.com/ventoy/Ventoy/releases/download/
v1.0.15/ventoy-1.0.15-linux.tar.gz

Ventoy: The Ultimate USB Loader

https://ventoy.net/en/index.html
https://github.com/ventoy/Ventoy/releases/download/v1.0.15/ventoy-1.0.15-linux.tar.gz


PCLinuxOS Magazine Page 19

The latest version is 1.0.15.

2) After downloading the script, unzip it somewhere
in your /home directory. When unzipping, it creates a
ventoy-1.0.15 folder. Change to this folder.

3) Connect your USB stick to the computer. You
should know how the system identifies your flash
drive (sdb, sdc, etc.). If you can't easily find out, use
Gparted to find out.

4) The syntax for Ventoy commands is:
Ventoy2Disk.sh CMD [OPTION]/dev/sdX, where

CMD:
-i install ventoy on sdX (fails if the disk is already

installed with Ventoy)
-I forces to install Ventoy on the sdX (whether

installed or not)
-u updates Ventoy in sdX

OPTION: (optional)
-r SIZE_MB preserves some space at the bottom

of the disk (for installation only)
-s enables secure boot support (default is

disabled)
-g uses GPT partition style, defaults to MBR style

(installation only)

In my case, the pendrive was recognized as sdb, so
the command was:
./Ventoy2Disk.sh -i /dev/sdb

5) Type Y.

6) It will ask for confirmation, so type Y again.

7) The script will be executed, the USB stick
partitioned and formatted, and the Ventoy boot
loader installed.

8) After partitioning and installation, the drive layout
looks like this:

9) And the drive is ready to be used, being identified
by the system as Ventoy.

10) To test, I copied some ISO’s to the USB stick
(PCLOS Lxqt, PCLOS Br LXDE, SlitAz, etc.)

Did it work? Yes! No doubt! Below are photos of the
tests.

1) With the computer turned off, the USB stick was
inserted. When turning on, in this case, I pressed
F12.

2) The device selection menu appears.

3) Choose the USB drive.

4) Upon boot, the Ventoy menu appears, with all the
ISOs stored on the first partition listed (next page,
top left).

All the ISO’s have booted and executed. However,
not all ISO’s are compatible with the scheme that
Ventoy uses as a bootloader. To check the
compatibility of a specific ISO with Ventoy, check the
Tested ISO page.

Ventoy: The Ultimate USB Loader

https://ventoy.net/en/isolist.html
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I hope you enjoyed this great tool, which is non-
destructive, simple and effective, and works for the
management of USB bootable USB drives, whether
they are just a single ISO or multiple ISOs.

A big (isolated) hug, and see you next month.

Screenshot ShowcaseScreenshot Showcase

Linux Training
Courses & Classes

Posted by Meemaw, July 24, 2020, running Xfce.

Ventoy: The Ultimate USB Loader
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http://www.linuxquestions.org
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by Ramchu

Amazon makes some popular devices for streaming video to your TV. In this
article, I am going to explain how to connect your computer to your Amazon Fire
TV Stick, Fire TV or Fire Cube, using ES File Explorer (on your Fire Stick) and
FileZilla (on your computer).

This is an easy and effective way to copy files to and from your computer to your
Amazon device.

Right about now you may be asking yourself, “why would I want to do this?”
Well, let's say that you have some photos, videos or even some apk files that you
have downloaded onto your computer and want to manually install them onto
your Amazon device. This would be the process you will need to follow.

So, let’s get started!

1. Startup your Fire TV Stick, and on the Home Screen, click the Search Icon.

2. Type ES File Explorer.

Click the ES File Explorer icon from the results.

Click the Get button.

The app will download and install automatically on the Fire Stick.

Transfer Files Directly To Your
Amazon Fire Stick From Your PC
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Click Open to run the app – OR - you may run the app later from Your Apps &
Channels section.

In Es File Explorer home screen, scroll down until you see View On PC and
select it.

Highlight TURN ON and select it.

This will open this screen.

Write down the ftp address that appears on your screen. It will be a two-part
address, like this: ftp://192.168.1.17:3721.

192.168.1.7 is the IP address (do not use this address, use what appears on your
screen).

3721 is the port number (again, use what appears on your screen).

Now on your computer

You will need an ftp client. We are going to use FileZilla. If you don’t already
have FileZilla, install it from the PCLinuxOS repository.

Open FileZilla. In the upper left corner, click on the File menu.

Transfer Files Directly To Your Amazon Fire Stick From Your PC
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Click Site Manager.

Click New Site.

Type the name of your New Site. I called mine Fire Stick, but you can name yours
whatever you choose.

Now in the Host box enter the IP address that you wrote down.

In the Port box enter the port number that you recorded from your screen.

Now in the Login Type click on the drop down and click Anonymous.

Now click Connect.

The box that pops up on screen is telling us that we are creating an insecure
connection. This is OK though, as you will only be using it in your home and NO
user names or passwords will be used or shared.

Click the Always allow insecure plain FTP for this server. Click OK.

Transfer Files Directly To Your Amazon Fire Stick From Your PC
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Now if you have answered everything correctly, you should see the Fire Stick files
on the right side of the FileZilla Screen.

That’s it! Now, just copy your files from your computer to your Amazon Fire Stick.
It would be a good idea to put your files in the directory that most closely matches
the type of file you are copying.
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by phorneker

By now, we have already seen the effects of opening
the economy amidst the current pandemic.

For me, this means working twice as long in my
retail job as before the pandemic, in addition to
keeping the house clean and safe. This also means
there will not be much time to write about anything in
the near future.

Having said that, there are a few things I would like
to share.

Setting Up Flatpak on PCLinuxOS

The Flatpak website (https://flatpak.org) does not list
PCLinuxOS as a supported distribution. This should
not discourage anyone from installing and using
Flatpak as it is available in the repository and
installable from Synaptic.

For the use of Flatpak, a connection to the Internet
(with an unlimited data plan) is highly
recommended as there will be extensive amounts
of downloading involved.

Once flatpak has been installed from Synaptic,
simple open a terminal window and type:

flatpak remote-add --if-not-exists flathub
https://flathub.org/repo/flathub.flatpakrepo

Then, go to Flathub (https://flathub.org) to find and
install Flatpak applications.

Useful tip: If there is an application not found in our
repository to install natively, or that application does

not work as expected, chances are you will be
able to use that same application as a Flatpak.

Such is the case with Mixxx. The version that was in
the repository no longer compiles in PCLinuxOS.
However, the Flatpak version of Mixxx does work
on PCLinuxOS, and therefore it is no longer
necessary to compile a separate version for the
repository.

LibreOffice is another application that can run on
PCLinuxOS in three ways: natively by installing
from lomanager, by way of a Flatpak, and by way of
an AppImage file.

Flathub also provides WPS Office, OnlyOffice, and
O2O, the last one being a MS Word 2019 clone for
those of you whose employers are still stuck in the
Microsoft way of doing things.

One downside to using Flatpaks, however, is that
the time it takes to install the application is
dependent on the number of files that need to be
downloaded. Many of these applications are
packaged with their own versions of QT, KDE,
GTK and GNOME libraries as separate downloads.

Thankfully, the Flatpak system keeps these libraries
separated from those that come with PCLinuxOS.

But, once these applications are installed, they
appear on your desktop menus as if they were
installed through Synaptic.

One advantage to Flatpaks is that applications
distributed as Flatpak packages will run on any
Linux distribution with Flatpak installed and
enabled.

Hence, it is possible to create a PCLinuxOS ISO

with Flatpak installed and enabled, instead of major
applications such as Firefox or LibreOffice. (Of
course, we still would need the GNU Compiler
Collection as well as the basic GNU utilities and
libraries.) This would reduce the size of the ISO and
the size of any updates necessary, leaving the major
applications to be installed as Flatpaks.

Don’t Forget AppImage

And then there is the AppImage container for
application distribution. AppImages are files that
package the application, its dependencies and some
basic GNU libraries in the ISO9660 format, not
unlike the typical data CD/DVD.

Repositories containing AppImage files tend to
contain older versions of popular applications (and
some not so popular ones as well). To use these,
simply download the AppImage file, then in a
terminal window, type chmod a+x (name of
AppImage file), then execute the file.

Unlike Flatpaks, AppImage files do not place menu
entries into your desktop, so you have to keep track
of which applications you have downloaded in the
AppImage format.

SuSE, Gmbh., through its Open Build Service,
makes it easy to create AppImage files. If you
have a project you want to distribute through
AppImage, the Open Build Service has a template
that you can use to build the project into a AppImage
file, which can then be executed in PCLinuxOS.

If you are using AppImages, and those images are
intended to run on a 32-bit Linux installation, you
should install the ia32-libs package from the
repository before attempting to run these
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AppImage files. (You can also install the ia32-libs
package by installing wine from the repository as it
pulls in the ia32-libs package in the process.)

Thankfully, the Open Build Service can generate 64-
bit AppImage files.

The Point Of All Of This?

If you have been following the current trends for
Information Technology in general, you will notice
that Linux is no longer just about the desktop
experience. One current trend brought into the open
source world in the past decade is the
containerization of applications.

FlatPak and AppImage are two examples of placing
applications inside of software containers. This
means that software developers can develop his/her
applications on one Linux distribution (such as
PCLinuxOS), and can then distribute that application
as a FlatPak or AppImage rather than creating
different RPM packages for different distributions.

In fact, the Open Build Service was originally
intended as a platform for developers to use to
create RPM and DEB packages for all the major
distributions. (Unfortunately, the RPM package
options do not include PCLinuxOS. However, you
can create AppImage files).

It is not just applications that run inside containers.
VirtualBox provides another container, in the form of
virtual machines. These are large files that contain
the machine’s configuration, the operating system,
and any applications installed.

To backup these large files, you will need to
have a USB flash drive of sufficient capacity or
an external hard drive. For VirtualBox, these files
are stored in a directory called VirtualBox VMs in
your home directory.

So how is a software container different from an

emulator? Software containers operate as virtual
machines with no specific hardware being
emulated. Containers can be accessed the same as
servers on a local network.

Emulators are virtual machines that can be
configured to emulate specific hardware, be it video,
audio, I/O ports, or networking cards, or to run
software designed for specific processors such as a
65C02, 680x0, Z80, x86 (32 or 64-bit), Alpha, or
ARM processor.

However, emulators are also containers in the sense
that applications running in these virtual machines
were designed to run in their emulated environment.
For example, Hatari is an emulator that was
designed to run Atari ST/TT/Falcon applications
under EmuTOS (the open source equivalent of Atari
TOS), though it is possible to run MiNT, NetBSD,
Minix 2, or a 68K version of Linux (the latter having
an ancient kernel) on the same emulator.

Whereas, with VirtualBox, you can run any x86
operating system (including FreeDOS and ArcaOS
5.x) inside a virtual machine. You can network virtual
machines in VirtualBox the same way as you can
network physical machines in a local network.

The Docker platform implements software containers
similar to VirtualBox. The difference here is that
docker runs as a daemon rather than an application
launchable from a menu on your desktop.

Possibilities for PCLinuxOS

I have seen what could be accomplished with certain
other distributions. The addition of support for
FlatPak and AppImage applications is a great start
towards the future of the distribution.

I know we all hate systemd, so I won’t even suggest
the inclusion of this monstrosity. The original
intention of systemd was to simplify the system
initialization functions found in SysV INIT scripts as

well as the scripts contained in the /etc/rc/rc.d
directory into one system controlled by one daemon.

Those of us who have worked with Mac OS-X or
Windows in the past know what a PITA it is to
maintain these operating systems and their startup
routines. After having looked at systemd and its
documentation, I do not see any reason why we
should ever implement such a thing here!!!!!!

But, what if there was another solution. MX-Linux
(formerly MEPIS) has a solution in the form of the
systemd API replacement package. Such a
package would not be easy to implement, and if
anyone had the time to do it, it could be done.

But then, if Flatpak can be implemented without
systemd, then is there really any reason why
technologies such as Docker, Kubernetes, or even
QEMU could be implemented without systemd?

(BTW, I got QEMU 5.0 to compile on PCLinuxOS
with all emulated processors enabled. It took
three hours on my laptop, but it got the job done. I
have yet to test it, though.)

Another possibility is to create an ISO with the
basics (including the base X.org installation), but
without the graphical interface launching at
startup. This would be useful for server installations,
for low-spec machines, and for those of you who
have trouble getting the graphical interface to work
at all..

The way to get this in PCLinuxOS is to open a
terminal window and type in init 3. This was the
default setup for early Red Hat Linux distributions,
and is still the default setup for Slackware Linux and
the stock version of Arch Linux.

This, of course will take some hand configuration to
get things working, but then, that was the way things
were done in the early 1990s with Linux.

The console mode would be useful for learning the
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Linux/UNIX command line, and tasks such as
system backups can be done much faster in text
mode than in graphical mode. (I know this because I
have done it.)

Now the other thing that has been on my mind.

Dating in the Era of the Pandemic

One thing is quite clear here. Dating in the traditional
sense has been made impossible due to the
Pandemic and the need to social distance. So let
us not go there. However, online dating has had a
resurgence, and not just with the dating apps for
smartphones either.

Videoconferencing services such as Zoom and
Google Hangouts made online dating closer to the
traditional model, in the sense that you get visual
contact as in the traditional methods (not just a
phone call or a text message).

But, can that be considered dating? I doubt it. But
what is the alternative? Taking a risk of getting
COVID with a physical presence? I don’t think so.

(Frankly, I could not get a date of any kind years
before the COVID pandemic.)

Unfortunately, online services are the only way to
go when it comes to meeting people in this era
of the pandemic.

We still have Match.com, eHarmony, OkCupid, Our
Time, Farmers Only, MyLife (this is a reputation
score provider that also happens to have a dating
service built on reputation profiles), Plenty Of Fish,
and Christian Singles.

There is also LavaLife and Quest Chat, which often
advertise on television more than they advertise on
the Internet.

But, is this really dating, either? Maybe in a few
years (optimistically), we could go back to the
traditional methods. Until then, this will have to do.

My main concerns about these services is the
integrity and privacy of the data that is posted on
these websites. It is possible to create fake profiles
on these sites just like it was to create fake profiles
on social media. (This is one reason why I don’t do

social media.) Another concern I have is the
security and safety of these websites (as in how
vulnerable are they to cyberattacks and data theft.)

In the case of LavaLife and Quest Chat, these
services were telephone dating services long
before the Internet became available to the
masses. You never know who is going to be on the
other end of the line.

Screenshot ShowcaseScreenshot Showcase

Posted by Yankee, July 9, 2020, running LXDE.
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by Paul Arnote (parnote)

Anyone who hasn’t heard of VLC by now has either been living under a rock, or
stranded for the past 20 years on a deserted island. VLC is a premiere,
multiplatform multimedia player. The open source VLC is available for Linux,
Unix, Windows, MacOS, iOS, Android, Tizen and BeOS. There’s not much that
VLC can’t do or play. For me, it’s my “go to” video player. Unless I’m playing a
whole list of songs, I usually opt for a simpler, lighter program to playback sound
files.

Just two years ago, Jean-Baptiste Kempf, the project lead for VLC since 2007
and the creator of the VideoLAN non-profit, refused 10’s of millions of Euros to
keep VLC ads-free. You have to applaud and admire him for sticking to his
principles. There are a LOT of people out there who would have caved in a
heartbeat to have access to that kind of wealth.

Background

As I’ve mentioned, VLC is the program I use as my default video player. And, as I
mentioned last month, I have a computer hooked to my HDTV in the living room,
serving as a player for digital video files to that TV.

Most anyone who has played music knows about *.m3u files. For those who may
not know, m3u files are playlists for (typically) music files. M3u files, in their
simplest iteration, are text files containing the paths (optional) and filenames
(required) of the digital sound files you want to play, in the order you want to play
them.

Here is one for my daughter’s favorite pop songs (I wonder if you can tell who
she likes):

01-Bobby-McFerrin---Don't-Worry-Be-Happy.mp3
02-Queen-–-Bohemian-Rhapsody.mp3
03-Queen---We-Will-Rock-You.mp3
04-Queen---We-Are-The-Champions.mp3
05-Queen---Another-One-Bites-the-Dust.mp3
06-Queen---Radio-Ga-Ga.mp3
07-The-Beatles---Yellow-Submarine.mp3
08-The-Beatles---Hey-Jude.mp3
09-The-Beatles---Here-Comes-The-Sun.mp3
10-The-Beatles---Let-It-Be.mp3
11-The-Beatles---Golden-Slumbers-Carry-That-Weight-The-End.mp3

And, VLC (as well as just about every other audio player on the planet) will read
m3u files just fine to playback your custom playlist.

But, when it comes to videos, m3u files don’t always “make the grade.”

VLC supports another playlist format, and from what I can tell, it’s “unique” to
VLC. It’s a bit more complex than a m3u playlist. Its file extension is *.xspf. You
can create the xspf playlist from within VLC by building it in VLC’s playlist
window, then saving the resulting playlist to your hard drive. Go ahead. Create
one in VLC and then open it up in a simple text editor. You will see how much
more complex a xspf file is than a m3u file.

Except I needed a better, easier way. I wanted a way to build the VLC playlist
from within my file manager. I didn’t want to open VLC every time I
wanted/needed to create a video playlist. Since I’m a devout Xfce user, that file
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manager is Thunar. I wanted to create a way to build the VLC playlist by way of a
Thunar Custom Action. Because of the increased “complexity” of the xspf playlist
file (compared to a m3u file), I wouldn’t be able to just enter a few commands and
have the playlist created. The xspf file creation would have to be controlled by a
bash script. Because I’m ultimately calling a bash script from a Thunar Custom
Action, I’m certain that the process should be repeatable from KDE and Dolphin,
Mate and Caja, and several other file managers with a minimum of extra effort. It
will also work from the command line, too.

I’m not the only person who has wondered about creating a xspf playlist file from
the command line either, gauging by the number of inquiries I found when
seeking out a solution. None of the touted “solutions” worked consistently – if at
all – for me. So, I set out to create my own solution.

After intensely studying the format of a xspf playlist file actually created by VLC,
and applying some “tips” I picked up looking at other “solutions” that didn’t fully
work out for my use, I was able to duplicate the VLC xspf playlist output
accurately via a bash script. You would be hard pressed to differentiate the file list
my bash script produces from the one that VLC produces.

My Solution

Below is the resulting bash script. It uses Zenity to allow the user to input the
name of the xspf file they are wanting to create.

1. #!/bin/bash
2.
3. # Create a XSPF playlist from a group of selected songs, videos
or movies.
4.
5. List=$(zenity --width=500 --entry --title="Make XSPF Playlist:
Enter a Name" --text="The xspf extension will be added for you
automatically.")
6. if [ $? == 1 ]; then
7. exit
8. fi
9.
10. ret="$?"
11.
12. if [ "$ret" = "252" ]; then
13. exit
14. elif [ "$ret" = "3" ]; then
15. exit
16. elif [ "$List" = "" ]; then
17. List="playlist"
18. fi

19.
20. n=0
21.
22. echo '<?xml version="1.0" encoding="UTF-8"?>' >./"$List".xspf
23. echo '<playlist xmlns="http://xspf.org/ns/0/"
xmlns:vlc="http://www.videolan.org/vlc/playlist/ns/0/"
version="1">' >>./"$List".xspf
24. echo '<title>Playlist</title>' >>./"$List".xspf
25. echo ' <trackList>' >>./"$List".xspf
26.
27. for i in "$@"; do
28. echo ' <track>' >>./"$List".xspf
29. echo ' <location>file://'"$i"'</location>'
>>./"$List".xspf
30. echo ' <extension
application="http://www.videolan.org/vlc/playlist/0">'
>>./"$List".xspf
31. echo ' <vlc:id>'"$n"'</vlc:id>'
>>./"$List".xspf
32. echo ' <vlc:option>file-
caching=1000</vlc:option>' >>./"$List".xspf
33. echo ' </extension>' >>./"$List".xspf
34. echo ' </track>' >>./"$List".xspf
35. let n=n+1
36. done
37.
38. echo ' </trackList>' >>./"$List".xspf
39. tid=0
40. echo ' <extension
application="http://www.videolan.org/vlc/playlist/0">'
>>./"$List".xspf
41. until [ $tid -eq "$#" ]
42. do
43. echo ' <vlc:item tid="'"$tid"'"/>' >>./"$List".xspf
44. let tid=tid+1
45. done
46.
47. echo ' </extension>' >>./"$List".xspf
48. echo '</playlist>' >>./"$List".xspf
49.
50. exit

I’ve numbered the lines so you can more easily see what’s on each line, since
some lines get “wrapped” due to their length.

I’ve saved the bash file in my $HOME/bin directory, which is in my PATH
statement so that it can be easily called into action without having to type in the
full path to the bash script every time I need to use it. I called the script make-vlc-
xspf-playlist.sh.
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To use it from the command line, I first move to directory containing the video files
I want to include in my playlist, then execute the command as follows:

make-vlc-xspf-playlist.sh [list of video files with full path and
filename]

Or, you can do it more easily, by using wildcards, like the command below,
instead of listing the full path and filename of the movies in your playlist
individually.

make-vlc-xspf-playlist.sh *.mp4

Here is a sample VLC xspf video playlist produced by the script:

1. <?xml version="1.0" encoding="UTF-8"?>
2. <playlist xmlns="http://xspf.org/ns/0/"
xmlns:vlc="http://www.videolan.org/vlc/playlist/ns/0/"
version="1">
3. <title>Playlist</title>
4. <trackList>
5. <track>
6. <location>file:///home/parnote-
ideapad/Movies/Transformers-Armada-
2003/S4/Transformers-Armada-S04E01---Depart.mp4</location>
7. <extension
application="http://www.videolan.org/vlc/playlist/0">
8. <vlc:id>0</vlc:id>
9. <vlc:option>file-caching=1000</vlc:option>
10. </extension>
11. </track>
12. <track>
13. <location>file:///home/parnote-
ideapad/Movies/Transformers-Armada-
2003/S4/Transformers-Armada-S04E02---Miracle.mp4</location>
14. <extension
application="http://www.videolan.org/vlc/playlist/0">
15. <vlc:id>1</vlc:id>
16. <vlc:option>file-caching=1000</vlc:option>
17. </extension>
18. </track>
19. <track>
20. <location>file:///home/parnote-
ideapad/Movies/Transformers-Armada-
2003/S4/Transformers-Armada-S04E03---Puppet.mp4</location>
21. <extension
application="http://www.videolan.org/vlc/playlist/0">
22. <vlc:id>2</vlc:id>
23. <vlc:option>file-caching=1000</vlc:option>
24. </extension>

25. </track>
26. <track>
27. <location>file:///home/parnote-
ideapad/Movies/Transformers-Armada-
2003/S4/Transformers-Armada-S04E04---Uprising.mp4</location>
28. <extension
application="http://www.videolan.org/vlc/playlist/0">
29. <vlc:id>3</vlc:id>
30. <vlc:option>file-caching=1000</vlc:option>
31. </extension>
32. </track>
33. <track>
34. <location>file:///home/parnote-
ideapad/Movies/Transformers-Armada-
2003/S4/Transformers-Armada-S04E05---Dash.mp4</location>
35. <extension
application="http://www.videolan.org/vlc/playlist/0">
36. <vlc:id>4</vlc:id>
37. <vlc:option>file-caching=1000</vlc:option>
38. </extension>
39. </track>
40. <track>
41. <location>file:///home/parnote-
ideapad/Movies/Transformers-Armada-
2003/S4/Transformers-Armada-S04E06---Drift.mp4</location>
42. <extension
application="http://www.videolan.org/vlc/playlist/0">
43. <vlc:id>5</vlc:id>
44. <vlc:option>file-caching=1000</vlc:option>
45. </extension>
46. </track>
47. <track>
48. <location>file:///home/parnote-
ideapad/Movies/Transformers-Armada-
2003/S4/Transformers-Armada-S04E07---Portent.mp4</location>
49. <extension
application="http://www.videolan.org/vlc/playlist/0">
50. <vlc:id>6</vlc:id>
51. <vlc:option>file-caching=1000</vlc:option>
52. </extension>
53. </track>
54. <track>
55. <location>file:///home/parnote-
ideapad/Movies/Transformers-Armada-
2003/S4/Transformers-Armada-S04E08---Cramp.mp4</location>
56. <extension
application="http://www.videolan.org/vlc/playlist/0">
57. <vlc:id>7</vlc:id>
58. <vlc:option>file-caching=1000</vlc:option>
59. </extension>
60. </track>
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61. <track>
62. <location>file:///home/parnote-
ideapad/Movies/Transformers-Armada-
2003/S4/Transformers-Armada-S04E09---Alliance.mp4</location>
63. <extension
application="http://www.videolan.org/vlc/playlist/0">
64. <vlc:id>8</vlc:id>
65. <vlc:option>file-caching=1000</vlc:option>
66. </extension>
67. </track>
68. <track>
69. <location>file:///home/parnote-
ideapad/Movies/Transformers-Armada-
2003/S4/Transformers-Armada-S04E10---Union.mp4</location>
70. <extension
application="http://www.videolan.org/vlc/playlist/0">
71. <vlc:id>9</vlc:id>
72. <vlc:option>file-caching=1000</vlc:option>
73. </extension>
74. </track>
75. <track>
76. <location>file:///home/parnote-
ideapad/Movies/Transformers-Armada-
2003/S4/Transformers-Armada-S04E11---Origin.mp4</location>
77. <extension
application="http://www.videolan.org/vlc/playlist/0">
78. <vlc:id>10</vlc:id>
79. <vlc:option>file-caching=1000</vlc:option>
80. </extension>
81. </track>
82. <track>
83. <location>file:///home/parnote-
ideapad/Movies/Transformers-Armada-
2003/S4/Transformers-Armada-S04E12---Mortal-Combat.mp4</location>
84. <extension
application="http://www.videolan.org/vlc/playlist/0">
85. <vlc:id>11</vlc:id>
86. <vlc:option>file-caching=1000</vlc:option>
87. </extension>
88. </track>
89. </trackList>
90. <extension
application="http://www.videolan.org/vlc/playlist/0">
91. <vlc:item tid="0"/>
92. <vlc:item tid="1"/>
93. <vlc:item tid="2"/>
94. <vlc:item tid="3"/>
95. <vlc:item tid="4"/>
96. <vlc:item tid="5"/>
97. <vlc:item tid="6"/>
98. <vlc:item tid="7"/>

99. <vlc:item tid="8"/>
100. <vlc:item tid="9"/>
101. <vlc:item tid="10"/>
102. <vlc:item tid="11"/>
103. </extension>
104. </playlist>

Again, I’ve applied line numbers to help compensate for the word wrapping, so
that it’s more intelligible.

Integrating Into Thunar, Via Thunar Custom Action

Once you get into Thunar’s “Edit” menu, choose the “Configure Custom
Actions…” menu item. Then, fill in the fields of the first tab (Basic) as in the image
above. I named it “Make VLC XSPF Playlist,” and gave it a description of “Make
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playlist for VLC video files.” Under the command entry, I entered make-vlc-xspf-
playlist.sh %F as the command to execute. Click on the “No Icon” button to
select an icon to use in Thunar’s right-click context menu next to the name.

Switch to the “Appearance Conditions” tab of the dialog box. Enter a single
wildcard * in the file pattern, and check the box next to “Video Files.” Then, click
on OK to save the new Thunar Custom Action.

Now, travel in Thunar to a directory holding the video files you want to place into
a VLC xspf playlist. Select the ones you want to add to your video playlist, then
right click on them. If you did everything correctly, you should see something like
in the image above. Select “Make VLC XSPF Video Playlist” from the right-click
context menu.

You should see the image above. Just enter the name for your video playlist,
without a file extension. The xspf file extension will be added for you
automatically. Your new playlist will be placed in the directory with your videos.
When you want to view the videos in that playlist, just double-click on the playlist
in Thunar, and VLC should open with the playlist preloaded. In VLC, right click on
the video you want to start with (it may not always be the first one listed … you

The place where breaking news,
BitTorrent and copyright collide

Make A VLC Video Playlist From The Command Line

http://torrentfreak.com/


PCLinuxOS Magazine Page 33

may be coming back to finish viewing a previous playlist that you didn’t
complete), and select “Play” from VLC’s right-click context menu.

Summary

I’m no bash guru. That is an absolute. I’m more of a bash basher. I have a LOT
more room for “growth” when it comes to my bash scripting skills. I can mostly get
things done by bashing around in bash. I also have pretty good luck finding code
snippets here and there, and then customize them to better fit the task I’m trying
to accomplish. So, there may be other ways to achieve what I did in my bash
script. But at the end of the day, it works. It works well, in fact. Not too bad for 41
lines of actual code (subtracting the nine blank lines inserted to promote
readability), if I do say so myself.

Now, when my son wants to watch a bunch of his animated Transformers
episodes (each only about 24 minutes long), I can just load up a whole season at
a time by double clicking on the premade VLC video playlist. Then, they play one
after another, until the playlist is exhausted.

To make it easier, I’ve got a copy of the script you can download from the
magazine’s website. It’ll save you a lot of typing, and a lot of possible errors. Just
remove the “.txt” file extension, and allow the file to be executed. The download is
only 1.6 KiB, so it should download rather quickly.
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by Electronic Frontier Foundation
Reprinted under Creative Commons Attribution License

Editor’s note: At least in the U.S., and most likely in most
every other part of the world, there is increasing concern
about governmental overreach, the invasion of privacy,
and the threat of general surveillance without cause. This
article will at least let people know what forms of
surveillance are employed, and where.

Atlas of Surveillance Shines Light on
Deployment of Cameras, Drones, and
More

San Francisco — The Electronic Frontier
Foundation (EFF), in partnership with the Reynolds
School of Journalism at the University of Nevada,
Reno, today launched the largest-ever collection of
searchable data on police use of surveillance
technologies, created as a tool for the public to learn
about facial recognition, drones, license plate
readers, and other devices law enforcement
agencies are acquiring to spy on our communities.

The Atlas of Surveillance database, containing
several thousand data points on over 3,000 city and
local police departments and sheriffs' offices
nationwide, allows citizens, journalists, and
academics to review details about the technologies
police are deploying, and provides a resource to
check what devices and systems have been
purchased locally.

Users can search for information by clicking on
regions, towns, and cities, such as Minneapolis,
Tampa, or Tucson, on a U.S. map. They can also

easily perform text searches by typing the names of
cities, counties, or states on a search page that
displays text results. The Atlas also allows people to
search by specific technologies, which can show
how surveillance tools are spreading across the
country.

Built using crowdsourcing and data journalism over
the last 18 months, the Atlas of Surveillance
documents the alarming increase in the use of
unchecked high-tech tools that collect biometric
records, photos, and videos of people in their
communities, locate and track them via their cell
phones, and purport to predict where crimes will be
committed.

While the use of surveillance apps and face
recognition technologies are under scrutiny amid the

COVID-19 pandemic and street protests, EFF and
students at University of Nevada, Reno, have been
studying and collecting information for more than a
year in an effort to, for the first time, aggregate data
collected from news articles, government meeting
agendas, company press releases, and social media
posts.

"There are two questions we get all the time: What
surveillance is in my hometown, and how are
technologies like drones and automated license
plate readers spreading across the country?" said
Dave Maass, a senior investigative researcher in
EFF's Threat Lab and a visiting professor at the
Reynolds School of Journalism. "A year a half ago,
EFF and the Reynolds School partnered to answer
these questions through a massive newsgathering
effort, involving hundreds of journalism students and

EFF Launches Searchable Database Of Police Agencies
& The Tech Tools They Use To Spy On Communities

https://www.eff.org/press/releases/eff-launches-searchable-database-police-agencies-and-tech-tools-they-use-spy
http://creativecommons.org/licenses/by/3.0/us/
http://atlasofsurveillance.org/
https://www.eff.org/deeplinks/2017/04/california-lets-end-unchecked-police-surveillance
https://www.eff.org/deeplinks/2017/04/california-lets-end-unchecked-police-surveillance
https://www.eff.org/deeplinks/2020/06/california-privacy-advocates-sue-vallejo-over-cell-site-simulator
https://www.eff.org/deeplinks/2020/06/california-privacy-advocates-sue-vallejo-over-cell-site-simulator
https://www.economist.com/open-future/2018/06/04/how-data-driven-policing-threatens-human-freedom
https://www.eff.org/issues/covid-19
https://www.eff.org/deeplinks/2020/06/quick-and-dirty-guide-cell-phone-surveillance-protests
https://www.unr.edu/journalism
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volunteers. What we found is a sprawling spy state
that reaches from face recognition in the Hawaiian
Islands to predictive policing in Maine, from body-
worn cameras in remote Alaska to real-time crime
centers along Florida's Gold Coast."

Information was collected on the most pervasive
surveillance technologies in use, including drones,
body-worn cameras, face recognition, cell-site
simulators, automated license plate readers,
predictive policing, camera registries, police
partnerships with Amazon’s Ring camera network,
and gunshot detection sensors. It also maps out
more than 130 law enforcement tech hubs that
process real-time surveillance data. While the Atlas
contains a massive amount of data, its content is
only the tip of the iceberg and underlines the need
for journalists and members of the public to continue
demanding transparency from criminal justice
agencies. Reporters, students, volunteers, and
watchdog groups can submit data or share data sets
for inclusion in the Atlas.

“The prevalence of surveillance technologies in our
society provides many challenges related to privacy
and freedom of expression, but it's one thing to know
that in theory, and another to see hard data laid out
on a map," Reynolds School Professor and Director
of the Center for Advanced Media Studies Gi Yun
said. "Over a year and a half, Reynolds School of
Journalism students at the University of Nevada,
Reno have reviewed thousands of news articles and
public records. This project not only informs the
public debate but helps these students improve their
understanding of surveillance as they advance in
their reporting careers."

For the Atlas: https://atlasofsurveillance.org

For more on street-level surveillance:
https://www.eff.org/issues/street-level-surveillance

Screenshot ShowcaseScreenshot Showcase

Posted by tuxlink, July 6, 2020, running KDE.
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by CgBoy

Gscan2pdf is a document scanning tool that allows
you to easily post-process and create PDF or DjVu
documents from your scanned pages. It has support
for Optical Character Recognition (OCR), and also
has a number of different image enhancing filters.

Gscan2pdf is pretty straightforward to use. Just hit
the little scanner button in the toolbar to open up the
Scan Document window. From here, you can select
your scanner from the dropdown menu (Scanning in
Gscan2pdf is handled via the SANE library). There
are some options available for changing the color
mode, page size and rotation, double or single sided
page mode, number of pages to be scanned, hue,
brightness, white level, and numerous other settings.

The images you scan will appear in the vertical bar
on the left, from which you can easily rearrange their
order by dragging them into place. You can also load
in any normal image files, such as pages you may
have already scanned, to process and turn into PDF
or DjVu documents.

After you’ve finished scanning, there are a number
of post-processing options you can use to help clean
up the scanned images. You can rotate, crop,
sharpen, invert, and change the brightness, contrast,
and threshold values of each page (The threshold
setting will make all pixels darker than a certain
value black, and change the rest to white).
Gscan2pdf also has a tool to help you better align
and center the scanned images, but I did not seem
to have great results when using it.

One of Gscan2pdf’s more interesting features is the
ability to generate text from scanned papers using
an Optical Character Recognition engine (Tesseract
or Cuneiform must be installed for it to work). The
generated text can then be used to allow you to
search for words and select text in the saved out
DjVu or PDF documents. You can start the OCR
process from the Tools menu and view the results in
the OCR Output tab. It gives you a few options, such
as which OCR engine to use, which language to
recognize, and whether or not to apply any threshold
changes in order to make the text on the scanned
image easier for the computer to read. The whole

OCR process is not terribly fast and can give mixed
results. However, it is still a useful option to have.

Gscan2pdf can export your scanned pages to DjVu
and obviously PDF documents, as well as a variety
of different image formats. If you have used the OCR
tool, you can also export the document as just a
plain TXT file containing the text generated by the
OCR engine.

Summary

I found Gscan2pdf to work fairly well for stitching
together some scanned pages I had from an old
telescope manual. I did experience some lag with
the user interface at times, but I think that was
probably related to the OCR feature, which seemed
to slow things down a bit when used. All in all,
Gscan2pdf is an excellent tool for anyone who
needs to scan a large amount of paperwork.

Repo Review: Gscan2pdf

http://www.commandlinefu.com
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As told to MrCrankyPants-YouCanToo

What is your name/username?
John Cate, or pyjujiop on the forums, which is a
handle I've used on the Internet for 20 years. I
originally created it for use on the AnandTech
swaplist.

How old are you?
47

Are you married, single?
Engaged and soon to be married to Kayrenne
Walker.

How about Kids, Grandkids (names and ages)?
When we marry, I will pick up a stepdaughter,
Natalie, who is 35. I have long considered her to be
family anyway.

Do you have pets, what is your favorite?
At the present time, we have no pets.

Are you retired, still working and if working, what
do you do?
I am a professional journalist who has been in the
profession since 1993. At the current time I am a
freelancer working for media relations firms and
open to new clients! My main client is operated by
an old colleague of mine, who is hoping to bring me
on full-time.

Where do you call home? What is it like? IE:
weather, scenery
Presently in Mount Airy, NC. Probably will move
closer to the Raleigh area once this coronavirus
epidemic has run its course. This is in the foothills of
the North Carolina mountains, and while it is not
truly Mayberry, there's a lot to see around here.

Where did you go to school and what is your
education level?
I have an AA degree and am very close to a
bachelor's degree from Strayer University, but not
currently attending.

What kind of things do you like doing? hobbies,
travel, fishing, camping?
We travel a lot, and I'm a computer enthusiast, as
you might imagine, and do a lot of that sort of thing
on the side. I could get the A+ cert anytime I wanted
to and probably will at some point.

Why and when did you start using Linux?
The first time I tried it was around the turn of the
century, when the only computing experiences I had
ever had were CP/M machines in the 1980s,
followed by the classic Mac OS and Windows 3x and
9x in the 1990s. I'd heard about Linux a lot, living in

PCLinuxOS Family Member Spotlight: pyjujiop
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the Raleigh area at the time, where Red Hat was
always in the news.

I dabbled with it off and on (the first distro I ever tried
was Mandrake, an ancestor of PCLinuxOS), but
never had time to really learn much about it. The first
time I used Linux seriously was Puppy 4.1.2 in the
mid-2000s on older hardware, and later on, I used
the old Zen-mini variant of PCLinuxOS on my main
computers as a secondary OS around 2009-2012.
However, I couldn't use Linux as my primary OS due
to my work needing Windows. When I finally was
able to make the move, late in 2015, I converted to
Mint Cinnamon. I returned to PCLinuxOS as my
main OS in January of 2019.

What specific equipment do you currently use
with PCLinuxOS?
I have two computers presently running PCLinuxOS
as their primary OS. One is a Dell Inspiron 1545
laptop that has been completely overhauled; it now
runs a 3.06 GHz T9900 CPU, 6 GB of RAM, and has
both a 256GB SSD and a 640GB HDD installed. The
other is a desktop with an Athlon X4 870K CPU at
3.9 GHz, with 16 GB of RAM and several HDDs and
SSDs installed in the case. We have two other
Windows machines and an Amazon tablet that Kay
uses.

Do you feel that your use of Linux influences the
reactions you receive from your computer peers
or family? If so, how?
Not really, because I have pretty much been using
my personal computer equipment for both personal
use and work for many years. I have the ability to
choose my own tools for the job and have never
been questioned on it. We still have a Windows
system at home because Kay requires it for certain
things, but I have not used Windows as my primary
OS for almost five years.

Most reactions I get are on the Q-and-A website
called Quora, where I frequently discuss Linux and
my choice of PCLinuxOS.

What would you like to see happen within
PCLinuxOS that would make it a better place.
What are your feelings?
Honestly, I have no complaints about it. I would like
PCLinuxOS to gain more users, but only because it
would hopefully get more people to donate. I have
no idea how Tex and the community manage to keep
it as well maintained as they do. I returned to
PCLinuxOS because I preferred the community-
based model and the philosophy of this distro over
using anything related to Ubuntu.

PCLinuxOS Family Member Spotlight is an exclusive,
monthly column by YouCanToo, featuring PCLinuxOS
forum members. This column will allow "the rest of us" to
get to know our forum family members better, and will
give those featured an opportunity to share their
PCLinuxOS story with the rest of the world.

If you would like to be featured in PCLinuxOS Family
Member Spotlight, please send a private message to
youcantoo, parnote or Meemaw in the PCLinuxOS forum
expressing your interest.

Screenshot ShowcaseScreenshot Showcase

Posted by Snubbi, July 4, 2020, running Mate.

PCLinuxOS Family Member Spotlight: pyjujiop
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The sun has got his hat on
Hip-hip hooray

The sun has got his hat on
In the forum today

Now we'll all be happy
Hip-hip hooray

The sun has got his hat on
In the forum today

He's been warming Texstar
Ideas anew

Feel the sun ray
He'll do the same for you

Let's all take a sun-bath
Hip-hip hooray

The sun has got his hat on
In the forum today

Everyone singing hear the bells ringing
Fun in the sun today

Users excited friends delighted
Fun in the sun today

ms_meme's Nook: The Sun Has Got His Hat On

MP3 OGG

http://pclosmag.com/html/Issues/202008/files/thesunhasgothishaton.mp3
http://pclosmag.com/html/Issues/202008/files/thesunhasgothishaton.ogg
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INGREDIENTS:

1 large bag of Fritos
1 can of chili (your favorite)
2 cups shredded cheddar
1 onion

DIRECTIONS:

Heat the chili in a pan.
Shred the cheese.
Dice the onion.
Open the bag of Fritos.

Take a bowl, put as many fritos in
the bottom as you'd like, then
pour some hot chili on top, and
sprinkle on some onions and
cheese.

TIPS:

Add sour cream, jalapeños
chives, bacon, olives, whatever
you want.

PCLinuxOS Recipe Corner Bonus

FRITO PIE aka Walking Taco

http://pclostalk.pclosusers.com
http://www.linuxquestions.org
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SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
tiles with which to make as long of a word
as you possibly can. Words are based on
the English language. Non-English
language words are NOT allowed.
2. Red letters are scored double points.
Green letters are scored triple points.
3. Add up the score of all the letters that
you used. Unused letters are not scored.
For red or green letters, apply the
multiplier when tallying up your score.
Next, apply any additional scoring
multipliers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your tiles in a set to
make your word. You will not necessarily
be able to use all seven (7) of the letters in
your set to form a “legal” word.
5. In case you are having difficulty seeing
the point value on the letter tiles, here is a
list of how they are scored:

0 points: 2 blank tiles
1 point: E, A, I, O, N, R, T, L, S, U
2 points: D, G
3 points: B, C, M, P
4 points: F, H, V, W, Y
5 points: K
8 points: J, X
10 points: Q, Z

6. Optionally, a time limit of 60 minutes
should apply to the game, averaging to 12
minutes per letter tile set.
7. Have fun! It's only a game!

SUDOKU RULES: There is only one valid solution to each
Sudoku puzzle. The only way the puzzle can be considered
solved correctly is when all 81 boxes contain numbers and the
other Sudoku rules have been followed.

When you start a game of Sudoku, some blocks will be prefilled
for you. You cannot change these numbers in the course of the
game.

Each column must contain all of the numbers 1 through 9 and
no two numbers in the same column of a Sudoku puzzle can
be the same. Each row must contain all of the numbers 1
through 9 and no two numbers in the same row of a Sudoku
puzzle can be the same.

Each block must contain all of the numbers 1 through 9 and no
two numbers in the same block of a Sudoku puzzle can be the
same. D

o
w

n
lo

ad
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u
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o
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n
s

H
er

e

Possible score 285, average score 200.

PCLinuxOS Puzzled Partitions

http://pclosmag.com/html/Issues/202008/files/2020-08-PuzzleSolutions.pdf
http://www.scrabblesite.com/scrabble/rules/
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armyworm assassin bug
bumblebee butterfly
carpenter ant caterpillar
chrysalis cicada
cricket cutworm
damselfly dragonfly
dung beetle firefly
grasshopper gypsy moth
harlequin bug honeybee
hornet japanese beetle
jumping bean june bug
katydid kissing bug
lacewing ladybug
leafhopper lightning bug
mayfly meadowhawk
milkweed bug mosquito
nymph praying mantis
robber fly scarab
stag beetle termite
tsetse fly walking stick
wasp weevil

yellowjacket

Download Puzzle Solutions Here
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1. A flat-bodied, brightly colored stinkbug of North and
Central America that is destructive to cabbage and
other cruciferous plants.

2. A large black and reddish-orange bug that feeds
chiefly on milkweed

3. A family of about 1,200 species of beetles, whose
name is derived from the large and distinctive
mandibles found on the males of most species,
which resemble the antlers of deer.

4. Any of various large bloodsucking bugs and
especially some assassin bugs including some
capable of inflicting painful bites

5. A small metallic green and brown scarab beetle
that as a grub feeds on the roots of grasses and
decaying vegetation and as an adult eats foliage
and fruits

6. Any of a family of bugs that are usually predatory
on insects, though some (such as a kissing bug)
suck the blood of mammals

7. The larva of an insect (such as a grasshopper, true
bug, or mayfly) with incomplete metamorphosis

8. An insect which most closely resembles a plant
stalk. It’s natural camouflage makes it harder to be
seen by predators.

9. A giant silk moth widespread and often abundant in
Asia that is cultured for silk in some places

10. Any of various insects having delicate lacelike
wing venation, long antennae, and often brilliant
eyes

11. The hardened outer protective layer of an insect
in development between larva and fully developed

12. Any of numerous often brightly colored, predatory
insects that have a long slender body with
transparent veined wings and that hold the wings
together over the abdomen when at rest.

13. Any of various smooth-bodied moth caterpillars
which often feed on young plant stems.

14. Any of a family of jumping insects noted for the
chirping notes produced by the male

15. An insect having a triangular head with bulging
eyes supported on flexible necks, with or without
wings; their upright posture with folded limbs gives
it the nickname.

16. Any of numerous moths whose larvae travel in
multitudes from field to field destroying grass,
grain, and other cropsDownload Puzzle Solutions Here
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Mixed-Up-Meme Scrambler
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More Screenshot Showcase

Posted by luikki, July 8, 2020, running KDE. Posted by parnote, July 19, 2020, running Xfce.

Posted by brisvegas, July 2, 2020, running Mate. Posted by Mr Cranky Pants-YouCanToo, July 1, 2020, running Mate.




